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Introduction

Welcome to Adobe Illustrator CC on Demand, a visual quick
reference book that shows you how to work efficiently with
Illustrator.  This book provides complete coverage of basic to
advanced Illustrator skills.

How This Book Works
You don’t have to read this book in any particular order.
We’ve designed the book so that you can jump in, get the
information you need, and jump out. However, the book does
follow a logical progression from simple tasks to more com-
plex ones. Each task is presented on no more than two facing
pages, which lets you focus on a single task without having
to turn the page. To find the information that you need, just
look up the task in the table of contents or index, and turn to
the page listed. Read the task introduction, follow the step-
by-step instructions in the left column along with screen illus-
trations in the right column, and you’re done.

What’s New
If you’re searching for what’s new in Illustrator CC, just look
for the icon: New!. The new icon appears in the table of con-
tents and throughout this book so you can quickly and easily
identify a new or improved feature in Illustrator. A complete
description of each new feature appears in the New Features
guide in the back of this book.

Keyboard Shortcuts
Most menu commands have a keyboard equivalent, such as
Ctrl+P (Win) or A+P (Mac), as a quicker alternative to using
the mouse. A complete list of keyboard shortcuts is available
on the web at www.perspection.com.

How You’ll Learn

How This Book Works

What’s New

Keyboard Shortcuts

Step-by-Step Instructions

Real World Examples

Workshops

Adobe Certification

Get More on the Web

http://www.perspection.com
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Step-by-Step
Instructions
This book provides concise step-
by-step instructions that show you
“how” to accomplish a task. Each
set of instructions includes illus-
trations that directly correspond to
the easy-to-read steps. Also
included in the text are time-
savers, tables, and sidebars to
help you work more efficiently or
to teach you more in-depth infor-
mation. A “Did You Know?” pro-
vides tips and techniques to help
you work smarter, while a “See
Also” leads you to other parts of
the book containing related infor-
mation about the task. 

Real World Examples
This book uses real world exam-
ple files to give you a context in
which to use the task. By using
the example files, you won’t waste
time looking for or creating sam-
ple files. You get a start file and a
result file, so you can compare
your work. Not every topic needs
an example file, such as changing
options, so we provide a complete
list of the example files used
throughout the book. The example
files that you need for project
tasks along with a complete file
list are available on the web at
www.queondemand.com or
www.perspection.com.

Real world
examples help
you apply what
you’ve learned
to other tasks.

Illustrations
match the
numbered
steps.

Numbered
steps guide
you through
each task.

Did You Know? alerts
you to tips, techniques
and related information.

See Also points you to
related information in
the book.

Easy-to-follow
introductions
focus on a
single concept.

http://www.queondemand.com
http://www.perspection.com


The Workshops
walk you through
in-depth projects
to help you put
Illustrator to
work.

Introduction xix

Workshops
This book shows you how to put
together the individual step-by-
step tasks into in-depth projects
with the Workshop. You start each
project with a sample file, work
through the steps, and then com-
pare your results with a project
results file at the end. The Work-
shop projects and associated files
are available on the web at
www.queondemand.com or
www.perspection.com.

Adobe Certification
This book prepares you fully for
the Adobe Certified Expert (ACE)
exam for Adobe Illustrator CC.
Each Adobe Certified Expert certifi-
cation level has a set of objec-
tives, which are organized into
broader skill sets. To prepare for
the certification exam, you should
review and perform each task
identified with an ACE objective to
confirm that you can meet the
requirements for the exam. Infor-
mation about the ACE program is
available in the back of this book.
The Adobe Certified Expert objec-
tives and the specific pages that
cover them are available on the
web at www.queondemand.com
or www.perspection.com.

http://www.queondemand.com
http://www.perspection.com
http://www.queondemand.com
http://www.perspection.com
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Get More on the Web
In addition to the information in
this book, you can also get more
information on the web to help
you get up-to-speed faster with
Illustrator CC. Some of the infor-
mation includes: 

Transition Helpers
◆ Only New Features.

Download and print the new
feature tasks as a quick and
easy guide.

Productivity Tools
◆ Keyboard Shortcuts.

Download a list of keyboard
shortcuts to learn faster ways
to get the job done. Also
available in the back of this
book.

More Content
◆ Photographs. Download

photographs and other
graphics to use in your
Illustrator documents. 

◆ More Content. Download
new content developed after
publication.

You can access these additional
resources on the web at
www.perspection.com.

Additional
content
is available
on the web. 

http://www.perspection.com
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What You’ll Do

63

Working with Objects

Introduction

Adobe Illustrator is an application that that provides tools you
can use to work with vector graphics, which include vector
shapes and vector objects. Vector graphics are created using
mathematical shapes, not pixels, and that's why vector
shapes are considered resolution-independent. When you
draw a vector object, you create one or more lines called a
path. A path is made up of one or more curved or straight line
segments. The start and end points for a line segment is
known as an anchor point, which you can drag to change and
move. 

Illustrator provides drawing tools on the Tools panel that
you can use to create a variety of shapes, including rectan-
gles, rounded rectangles, ellipses, polygons, stars, flares,
lines, arcs, spirals, rectangle grids, and polar (circular) grids.
After you draw an object, you can use Illustrator selection
tools to modify it. The two main selection tools are the
Selection tool and the Direct Selection tool. The Selection tool
allows you to select entire objects, while the Direct Selection
tool allows you to select paths and segments. In addition to
these tools, you can also use the Select menu. The Select
menu provides a variety of powerful selection commands for
you to use in a document or artboard. For example, you can
select objects whose attributes (including Appearance,
Blending Modes, Fill & Stroke, Opacity, and Stroke Color) are
similar to the current or last selection. 

After you select one or more objects, you can move,
align, group, and transform them. The transformation tools
allow you to rotate, scale (resize), reflect (mirror image), or
shear (slant) an object. 

What You’ll Do

Understand Vector and Raster Images

Understand Paths

Select a Drawing Mode

Create Pixel Aligned Objects

Create Rectangles and Ellipses

Create Polygons and Stars

Create Line Segments

Create Arcs, Spirals, and Grids

Use the Shape Builder Tool

Create Perspective Objects

Use the Selection Tool

Use the Direct Selection Tool

Use the Lasso Tool

Use the Magic Wand Tool

Select and Group Objects

Save and Edit Selections

Move and Duplicate Objects

Align and Distribute Objects

Transform Objects

Rotate, Scale, Reflect, or Shear Objects

Apply Multiple Transformations

Reshape Objects with Envelopes
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Illustrator is an application that gives you
great control over vector graphics, which
include vector shapes and vector objects.
Vector graphics are created using mathemati-
cal shapes, not pixels, and that's why vector
shapes are considered resolution-independ-
ent. For example, if you enlarge a vector
image to 100 times its original size, Illustrator
merely changes the mathematical formulas to
reflect the new size, and since vector shapes
are constructed of mathematical data instead
of pixels, file sizes are extremely small.

Raster graphics, such as bitmaps and pho-
tographs, are images creating using individ-
ual pixels that identify one piece of color
information. The reason raster images are
considered resolution-dependent is that once
the image is created or scanned, any enlarge-
ment of the image forces Illustrator to enlarge
and average the existing color information in
the document. This process, called interpola-
tion, is what causes enlarged raster images to
become blurred, or pixelated. 

Understanding Vector and Raster Graphics

Raster ImageVector Image

Close up shows lines Close up shows pixels 
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When you draw an object, you create one or
more lines called a path. A path is made up of
one or more curved or straight lines, known
as segments. The start and end points for a
segment is called an anchor point. An anchor
point is a bending point to modify the line
segment. A path can be open or closed. An
open path has open-ended endpoints, such as
a line, while a closed path has connected end-
points, such as a circle. Paths can have two
types of anchor points: smooth points or cor-
ner points. A smooth point connects two
curved segments to create a smooth line,
while a corner point connects two straight or
curved segments to create a path direction
change. You can draw a path using both
smooth and corner points. The outline of a
path is called a stroke, which you can format
with different characteristics. You can specify
stroke weight (thickness), color, or a dashed
pattern. The interior of an open or closed path
is called a fill, which you can also format with
a color or gradient.

You can change the shape of a path by
dragging its anchor point. A selected anchor
point or endpoint appears as a solid square,
while an unselected one appears as a white
square.  When you select an anchor point
with a curved segment, a direction line
appears with direction points on each end,
which you can drag to change the shape of
the path. When you change the shape of a
smooth point with curved segments on each
side, both segments get changed. When you
change a shape of a corner point, the corner
is maintained, but adjusted based on the
change. 

Working with Anchor Points
In Illustrator, you can show or hide anchor
points, direction lines, and direction points by
choosing the View menu, and then choosing
Show Edges or Hide Edges. If you want to
show or hide direction lines for selected
anchor points, select the Direct Selection tool,
select the anchor point that you want, and
then click Show Handles For Multiple Selected
Anchor Points or Hide Handles For Multiple
Selected Anchor Points button in the Control
panel.

You can specify options in the Selection &
Anchor Display preferences to always show
handles when multiple anchor points are
selected (this option is turned off by default).

Understanding Paths

Closed path

Open path
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Selecting a Drawing
Mode

Select a Drawing Mode

Select the Drawing Mode tool on
the Tools panel:

◆ Draw Normal. Draws an object
on top of any other object; the
default mode.

◆ Draw Behind. Draws an object
behind all objects (no selection)
or directly behind a selected
object.

◆ Draw Inside. Draws an object
inside a single selected object.

TIMESAVER Press Shift+D to
cycle through the Drawing Mode
tools.

1

In Illustrator, you can specify how and where you want to draw an
object. You can draw on top of an object, behind an object, or inside an
object using one of the following drawing modes: Draw Normal, Draw
Behind, or Draw Inside. Draw Normal mode is the default drawing mode
and the one used in previous versions of Illustrator. The Draw Behind
mode allows you to draw behind all objects on a selected layer (no
other objects selected). If an object is selected, the new object is drawn
directly behind it. The Draw Inside mode allows you to draw inside a
single selected object, which automatically creates a clipping mask
from the selected object. You can select a drawing mode at the bottom
of the Tools panel or use the Shift+D keyboard shortcut to cycle through
each one.

Did You Know?
You can create a clipping mask using
the Draw Inside mode. Select the path
you want to draw, and then click the
Draw Inside mode button on the Tools
panel. Subsequent paths are clipped
by the selected path until you switch to
the Draw Normal mode. The clipping
masks created using the Draw Inside
mode retain the appearance on the
clipping path unlike the Make com-
mand on the Clipping Mask submenu
on the Object menu. 

1

Draw Inside

Draw Behind

Draw Normal

Draw Normal

Draw Behind

Draw Inside
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Creating Pixel Aligned
Objects

Work with Pixel Aligned
Objects
◆ Align All Objects in a New

Document. Click the File menu,
click New, specify new document
settings, select the Align New
Objects To Pixel Grid check box in
the Advanced section, and then
click OK.

◆ Align Existing Objects. Select the
object, open the Transform panel,
and then select the Align To Pixel
Grid check box. If not available,
click the Options button, and then
click Show Options.

◆ Not Align Objects. Select the
objects you want to change, click
the Select menu, point to Object,
and then click Not Aligned To
Pixel Grid.

◆ View The Pixel Grid. Click the
View menu, click Pixel Preview,
and then zoom to 600% or higher. 

◆ To set preferences for viewing
pixel grid, click the Edit (Win)
or Illustrator (Mac) menu, point
to Preferences, click Guides &
Grid, select the Show Pixel
Grid (Above 600% Zoom) check
box, and then click OK.

Pixel aligned vector objects allow you to create precisely drawn images
that look crisp and sharp for use on different outputs, such as the Web
and mobile devices. The Align to Pixel Grid option enables the vertical
and horizontal segments of the paths of an object to be nudged and
aligned to the pixel grid. The stroke width values become full integer to
create crisp paths. To view the pixel grid, zoom to 600% or higher in
Pixel Preview mode. The Align to Pixel Grid option remains enabled with
the object until it’s disabled. You can set the option in the Advanced sec-
tion of the New Document dialog box or the Options menu on the
Transform panel. The option in the New Document dialog box applies it
any new objects in the document. You cannot pixel-align objects without
paths, such as rasters, raster effects, and text objects.

Align To Pixel Grid option
in the Transform panel

Pixel Preview at 600% Object aligned to pixel grid
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Creating Rectangles
and Ellipses

Draw an Ellipse or Circle

Select the Ellipse tool on the Tools
panel.

TIMESAVER Press L to select
the Ellipse tool.

Select a Stroke and Fill Color from
the Colors area of the Tools panel.

Click and drag on the artboard,
and then release the mouse. 

TIMESAVER Press and hold
Shift while you drag to create a
circle.

To create an oval or circle with a
specific width and height, click on
the artboard where you want the
top left corner, enter width and
height values, and then click OK.
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The Illustrator Tools panel includes several tools for quickly creating
simple geometric vector shapes. They are easy to use; you just click and
drag on the Stage to create the shapes. The Rectangle tool creates rec-
tangles with square or rounded corners. The Ellipse tool creates circular
shapes such as ovals and circles. These shapes can be comprised
either of Strokes, which are lines that surround and define the shape, or
Fills, which can be a color or texture inside the shape, or both.

Did You Know?
You can enter values ranging from 0 to
16,383 points in the Rounded
Rectangle Settings dialog box. A value
of zero gives you a straight-sided-
square. Higher numbers produce
squares with more rounded sides.

You can draw shapes without a stroke
or a fill. Set either of these properties
to No Fill in the Colors section of the
Tools panel or in the Color panel.
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Draw a Rectangle or Rounded
Rectangle

Click the Rectangle or Rounded
Rectangle tool on the Tools panel. 

TIMESAVER Press M to select
the Rectangle tool.

Select a Stroke and Fill color from
the Colors area of the Tools panel. 

Click and drag on the artboard,
and then release the mouse. 

TIMESAVER Press and hold
Shift while you drag to create a
square.

To create a square, rectangle, or
rounded rectangle with a specific
width and height, click on the
artboard where you want the top
left corner, enter width and height
values, and then click OK.
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Did You Know?
You can change the corner radius for a
rounded rectangle. While you drag a
rounded rectangle, press the Up Arrow
or Down Arrow key. To create square
corners, press the Left Arrow key. To
create corners with maximum round-
ness, press the Right Arrow key.

You can draw shapes with no stroke
or fill. If you want to draw an oval or a
rectangle without a stroke or fill, you
can set either of these options to No
Fill in the Colors area of the Tools panel
or in the Color panel.

You can create a flare shape using the
Flare tool. Select the Flare tool on the
Tools panel, click and drag on the art-
board, and then release the mouse. 
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Creating Polygons 
and Stars

Draw a Polygon or Star Shape

Select the Polygon or Star tool on
the Tools panel. 

The pointer becomes a crosshair
that you can drag anywhere on the
artboard.

Select a Stroke and Fill color from
the Colors area of the Tools panel. 

Click and drag on the artboard,
and then release the mouse. 

TIMESAVER Press and hold
Shift while you drag to create a
proportional shape.

To create a shape with a specific
radius and number of sides or
points, click on the artboard where
you want the center of the shape,
enter the following values, and
then click OK.

◆ Polygon. Enter a radius and
number of sides for the
polygon. To create a triangle,
enter 3 sides.

◆ Star. Enter radius 1 for the
distance from the center of the
star to the innermost points and
enter radius 2 for the distance
from the center to the
outermost points.
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The Polygon and Star tools work in much the same way as the Ellipse
and Rectangle tools do to allow you to easily create complex vector
shapes. You can use these tools to create either polygons or stars.
Polygons are shapes based on a center radius and a number of sides,
while stars are shapes based on two center radiuses: one for the dis-
tance from the center of the star to the innermost points, and another
for the distance from the center to the outermost points. Experiment
with several options to get the kind of shape you want.

1

2

3

Polygon options4

Star options4
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Creating Line
Segments

Draw a Line Segment

Click the Line Segment tool on the
Tools panel. 

The pointer becomes a crosshair
that you can drag on the artboard.

TIMESAVER Press \ to select
the Line tool.

Select a Stroke color from the
Colors area of the Tools panel. 

Click and drag on the artboard,
and then release the mouse when
the line is the length you need. 

TIMESAVER Hold down the
Shift key, and then drag to draw a
45, 90, or 180 degree line. 

To create a line with a specific
length and angle, click on the
artboard where you want the line
to begin, enter length and angle
values, select the Fill Line check
box to fill the line with the current
fill color, and then click OK.
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The Line Segment tool draws perfectly straight lines in any direction
you drag your mouse. In Illustrator, a line is called a stroke and there is
a variety of thicknesses, styles, colors, and fills that can be applied to it.
You can also create your own line style for specific types of dashed,
dotted, or artistic lines. You can constrain the path a line draws to 45-
degree angles or create closed shapes by intersecting the lines you
draw.
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Creating Arcs and
Spirals

Draw an Arc

Click the Arc tool on the Tools
panel.

The pointer becomes a crosshair
that you can drag on the artboard.

Select a Stroke color from the
Colors area of the Tools panel. 

Click and drag on the artboard,
and then release the mouse when
the arc is the length you need. 

To create an arc with specific
settings, click on the artboard
where you want the arc to begin,
enter x and y lengths, specify type
(open or closed), arc direction
(Base Along) and slope options,
select the Fill Arc check box to fill
the arc with the current fill color,
and then click OK.

4

3

2

1

The Arc and Spiral tools make it easy to create unique and interesting
shapes. These tools draw curved lines to create an individual arc or a
Spiral wind. An arc consists of an x and y axis length, open or closed
path, arc direction (known as the Base Along), arc slope, and arc fill
(optional). A Spiral consists of a radius from the center to the outermost
point in the Spiral, decay (the amount each wind decreases), number of
segments for the spiral, and Spiral style. Each full wind of a Spiral con-
sists of four segments.
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Draw a Spiral

Click the Spiral tool on the Tools
panel.

The pointer becomes a crosshair
that you can drag on the artboard.

Select a Stroke color from the
Colors area of the Tools panel. 

Click and drag on the artboard,
and then release the mouse when
the Spiral is the length you need. 

To create a Spiral with specific
settings, click on the artboard
where you want the Spiral to
begin, enter a radius (distance)
from the center to the outermost
point, decay percentage (amount
of the wind decreases), the
number of segments, and style
options, and then click OK.
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Creating Grids

Draw Rectangle Grids

Click the Rectangle Grid tool on
the Tools panel. 

The pointer becomes a crosshair
that you can drag on the artboard.

Select a Stroke color from the
Colors area of the Tools panel. 

Click and drag on the artboard,
and then release the mouse when
the grid is the size you need. 

To create a grid with specific
settings, click on the artboard
where you want the grid reference
point, enter a width and height for
the grid, specify the number of
horizontal and vertical dividers,
select the Use Outside Rectangle
As Frame check box to replace
individual segments with a
separate rectangle object, select
the Fill Grid check box to fill the
grid with the current fill color, and
then click OK.
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The grid tools on the Tools panel allow you to create a rectangular or
circular polar grid. The Rectangular Grid tool creates rectangular grids
of a specified size and number of horizontal and vertical dividers. The
Polar Grid tool creates concentric circles of a specified size and spe-
cific number of concentric and radial dividers.
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Draw Circular Polar Grids

Click the Polar Grid tool on the
Tools panel. 

The pointer becomes a crosshair
that you can drag on the artboard.

Select a Stroke color from the
Colors area of the Tools panel. 

Click and drag on the artboard,
and then release the mouse when
the grid is the size you need. 

To create a grid with specific
settings, click on the artboard
where you want the grid reference
point, enter a width and height for
the grid, specify the number of
concentric and radial dividers,
select the Create Compound Path
From Ellipses check box to
replace circles with separate
compound paths, select the Fill
Grid check box to fill the grid with
the current fill color, and then 
click OK.
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Using the Shape
Builder Tool

Create an Object with the Shape
Builder Tool

Click the Selection tool on the
Tools panel, and then select only
the paths you want to merge to
create a shape. 

Click the Shape Builder tool on the
Tools panel. By default, merge
mode is selected.

To break or extract a region from
the shape, click the selected
region.

To merge paths, drag along the
region.  

The two regions get merged to
form a new shape. The attributes
from the region are applied to the
merging shapes.

TIMESAVER Pressing Shift as
you drag displays a rectangle
marquee for merging multiple
paths.

To erase paths, press Alt (Win) or
Option (Mac) and click the closed
region or edge you want to delete.
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The Shape Builder tool allows you to create complex objects by merg-
ing and erasing simpler objects. The Shape Builder tool selects edges
and regions of an object, which can be merged or erased to form a
new object. An edge is any section of a path that doesn’t intersect the
path of other selected objects and a region is a closed area. You can
also break overlapping objects to create new ones. The style attributes
of an object are adopted after the merge. By default, the Shape Builder
tool is in merge mode; however, you can switch to erase mode by using
the Alt (Win) or Option (Mac) key. Before you start using the Shape
Builder tool, you can set up and customize options, such as coloring
source, highlighting, and gap detection, to suit your own 
preferences.
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Set Shape Builder Tool Options

Double-click the Shape Builder
tool on the Tools panel. 

To detect and show the gap
between objects, select the Gap
Detection check box, and then
select a Gap Length, either Small
(3 points), Medium (6 points), or
Large (12 points), or select the
Custom check box and specify a
point size length.

IMPORTANT Make sure the
gap length value is close to the
actual gap length, otherwise
Illustrator may not detect it.

Specify the Options and Highlight
settings you want:

◆ Consider Open Filled Path as
Closed. Select to create an
invisible edge for an open path
to make a region.

◆ In Merge Mode, Clicking
Stroke Splits the Path. Select
to split the parent path into two;
the first edge you click
specifies the split location. 

◆ Pick Color From. Select Color
Swatches or Artwork as the
source for coloring objects. If
you select Color Swatches,
select the Cursor Swatch
Preview check box to preview
and select colors. 

◆ Fill. Select to highlight the
merged area in gray or mouse
over the selected path.

◆ Highlight Stroke When
Editable. Select to highlight
strokes you can edit in the
color you select.

Click OK.4
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Creating Perspective
Objects

Draw Perspective Objects

Click the Perspective Grid tool on
the Tools panel.

◆ If the grid doesn’t appear, click
the View menu, point to
Perspective Grid, and then
click Show Grid.

To select a perspective grid
preset, click the View menu, point
to Perspective Grid, point to a
Point Perspective (One, Two, or
Three), and then select a preset. 

To draw objects on the grid, do
any of the following: 

◆ Draw Perspective Objects.
Select a Line tool (other than
the Flare tool) or Rectangle
tool, and then drag to draw it. 

◆ Attach Normal Objects. Select
the plane to which you want to
use, select the normal object,
click the Object menu, point to
Perspective, and then click
Attach to Active Plane.

◆ Release Perspective Objects.
Select the attached object,
click the Object menu, point to
Perspective, and then click
Release with Perspective.

◆ Move Plane to Match Objects.
Select the existing object, click
the Object menu, point to
Perspective, and then click
Move Plane To Match Object.
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The Perspective Grid tool allows you to display a perspective grid that
you can use to draw shapes and create scenes with 1, 2, or 3-point
perspective. For example, you can create a row of trees down a street
to create perspective. The perspective grid provides presets with a 1, 2,
or 3-point perspective to help you get started. You can change the
viewing angle and distance along with widgets to control vanishing
points, horizon height, ground level, and the origin. You can draw
objects directly on the perspective grid or attach existing ones to it. If
you want to match the depth or height of an existing perspective
object, you can use the Move Plane To Match Object command to
adjust the grid, so you can draw or adjust another object to it.

21

3 Drawn perspective object
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Adjust the Perspective Grid

Click the Perspective Grid tool on
the Tools panel.

◆ If the grid doesn’t appear, click
the View menu, point to
Perspective Grid, and then click
Show Grid.

To select the active grid plane, click
a plane in the cube (Right, Left, or
Horizontal) in the Plane Switching
Widget. Click the area outside the
cube to select no plane.

To adjust the perspective grid, drag
the left or right controls on the grid
for any of the following: 

◆ Ground Level. Moves the
perspective grid. 

◆ Vanishing Points. Adjusts the
perspective in or out.

◆ Horizon Height. Adjusts the
horizon line up or down.

◆ Extend the Grid. Extends or
shortens the perspective grid.

◆ Grid Plane Controls. Adjust the
Right, Horizontal, or Left. 

◆ Grid Cell Size. Increases or
decreases the grid cell size.

◆ Origin. Adjusts the X and Y
coordinates of the grid plane. 

To set perspective grid related
options, click the View menu, point
to Perspective Grid, and then click
any of the following: 

◆ Show/Hide Rulers. Shows or
hides the ruler on the height line. 

◆ Snap to Grid. Snaps an object to
a perspective gridlines. 

◆ Unlock/Lock Grid. Unlocks or
locks the perspective grid. 

◆ Lock Station Point. Locks the
station point in place. When you
move one vanishing point, the
other one moves in sync. 
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1 point perspective 2 point perspective

3 point perspective
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Working with
Perspective Objects

Modify Perspective Objects

Click the View menu, point to
Perspective Grid, and then click
Show Grid.

Click the Perspective Selection
tool on the Tools panel.

To work with perspective objects
on the grid, do any of the following: 

◆ Move Perspective Objects.
Select the object, and then drag
it to another position or use the
Arrow keys. Press tilde (~) to
constrain the move to parallel.

◆ Move or Copy Perspective
Objects and Grid Plane.
Double-click a grid plane
control, click the Move All
Objects or Copy All Objects
option, click OK, and then drag
the grid plane control.

◆ Copy Perspective Objects.
Select the object, and then
Option+drag (Mac) or Alt+drag
(Win) it to another position.

◆ Resize Perspective Objects.
Select the object, and then drag
a resize handle.

◆ Add Normal Objects. Select the
active plane, and then drag the
normal object to the plane. 

◆ Add Text and Symbols. Select
an existing normal text or
symbol, and then drag it on the
active plane. To modify the text
and symbols, use the Edit Text,
Edit Perspective, and Isolate
Selected Object buttons on the
Control panel.
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The Perspective Selection tool allows you to select, move, scale, copy,
and transform objects in perspective. You can also add normal objects,
text, and symbols to the perspective grid. When you move or change a
normal object to the perspective grid, its appearance and scale change
to adhere to the grid. You can select perspective objects in the grid with
the Perspective Selection tool by clicking individual objects or dragging
a selection marquee, just like normal objects. 

Three perspective objects on the grid;
they were moved, copied and resized.
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Customizing a
Perspective Grid

Set Perspective Grid Options

Double-click the Perspective Grid
tool on the Tools panel.

Select the Show Active Plane
Widget check box to display it.

Click the Widget Position list
arrow, and then select a position. 

Select the Anchor Point Of
Perspective Artwork or the
Intersection Of Gridlines check
boxes to specify the points where
you want to temporarily hide the
active plane with the Shift key. 

Click OK.

Create a Perspective Grid Preset

Click the View menu, point to
Perspective Grid, and then click
Define Grid to create a grid (steps
3 thru 6) or manually create one.

Click the View menu, point to
Perspective Grid, and then click
Save Grid As Preset.

Type a name for the preset.

Specify the perspective grid
settings you want.

Specify the grid color & opacity
settings you want.

Click OK.

To edit a grid preset, click the Edit
menu, click Perspective Grid
Presets, select a preset, click Edit,
make changes, and then click OK.
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If you create your own perspective grid, you save it as a preset  for use
later. You can create a perspective grid by using the Define Grid com-
mand to set exacting measurements and options or by manually adjust-
ing an existing grid, and then saving it as a preset, which you can edit
at any time. When you create or work with an existing perspective grid,
you can set grid options to show or hide the active plane widget,
change the widget position, and specify which points you want to use
to temporarily hide the active plane with the Shift key.
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When you create vector graphics in Illustrator,
they are comprised of distinct segments that
can be selected separately or as a whole with
a variety of selection tools. The type of editing
you need to perform determines which tool
you use. For example, a simple rectangle is
comprised of four line segments that sur-
round the contour of the shape and one fill in
the center. Each of these parts can be selected
as a group with the Selection tool or individu-
ally with the Direct Selection tool. To select an
object using the fill, you need to deselect the
Object Selection by Path Only check box in
Selection & Anchor Display preferences. If an
object is behind another object, you can use
the keyboard shortcut A+click (Mac) or
Ctrl+click (Win) to select it. The pointer
changes to an arrow with a small caret on the
first A/Ctrl+click; as you continue to click, the
selection moves through the objects under
the pointer. To use this option, you need to
select the Control (Win) or Command (Mac)
Click to Select Objects Behind check box in
Selection & Anchor Display preferences.

In addition to the Selection and Direct
Selection tools, you can also use the Group
Selection tool to select all the anchor points
on a single path. With the Group Selection
tool, click to select an object, click twice to
select the object’s group, and click three times
to select the group within the group (if avail-
able). The Group Selection tool is useful for
working with multiple objects. If you want to
work with an individual object without affect-
ing other objects, it’s better to use Isolation
Mode.

The Lasso tool is a classic selection tool
that allows you to select path points and seg-
ments by dragging a freeform marquee
around them. 

The Magic Wand tool allows you to select
objects of the same or a similar fill color,
stroke color, stroke weight, opacity, or blend-
ing mode.

Understanding Selections

Selection preferences
Selection tool

Lasso tool

Direct Selection tool

Magic
Wand

tool Group Selection tool
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Using the Selection 
Tool

Select an Object with the
Selection Tool 

Click the Selection tool on the
Tools panel. 

The pointer becomes an arrow.

TIMESAVER Press V to select
the Selection tool.

Position the arrow on the edge of
the object, and then click it. 

◆ You can also drag a marquee
across all or part of the object
to select the entire path.

◆ If the path has a color fill,
appears in Preview mode, and
the Object Selection by Path
Only check box is deselected in
Selection & Anchor Display
preferences, you can also click
the fill to select the object.

To add or subtract objects from the
selection, hold down the Shift key,
and then click unselected objects
to add or click selected objects to
subtract them from the selection.
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There are several ways to select objects in Illustrator. With the
Selection tool, you can select an object's stroke or fill. You can only
select an object using the fill if the path appears in Preview mode, and
the Object Selection by Path Only check box is deselected in Selection
& Anchor Display preferences. After you select one or more objects,
you can add or subtract objects to/from the selection. In addition, you
can use the Selection tool and drag a marquee to select parts of the
object or drag over a portion of it to create a selection rectangle.
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Using the Direct
Selection Tool

Select Anchor Points and
Segments with the Direct
Selection Tool 

Click the Direct Selection tool on
the Tools panel. 

The pointer becomes an arrow.

TIMESAVER Press A to select
the Direct Selection tool.

Position the arrow on the edge of
the path and click to select a
segment, and then click an anchor
point to select it.

◆ You can also select an anchor
point directly. Pass the pointer
over a path, point to an anchor
point and then click it.

◆ You can also drag a marquee
across all or part of the object
to select the entire path.

To add or subtract anchor points
or segments from the selection,
hold down the Shift key, and then
click unselected items to add them
or selected items to subtract them
from the selection.
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With the Direct Selection tool, you can select individual points and seg-
ments of a path. After you select one or more individual points and seg-
ments, you can add or subtract items to/from the selection. In addition,
you can also use the Direct Selection tool and drag a marquee to select
parts of the path or drag over a portion of it to create a selection rec-
tangle.
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Using the Lasso Tool

Select with the Lasso Tool

Click the Lasso tool on the Tools
panel.

Draw around the shapes you want
to select. 

To complete the selection, return
to the point where you started.
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Use the Lasso tool when you want to select shapes that are very close
to shapes you don't want to select. This tool allows you to draw around
the shape, selecting everything contained within the drawn area. When
you draw a selection, you can drag across a path to include it in the
selection instead of dragging completely around it. This selection tool is
useful when you are working with overlapping paths.

Did You Know?
You can select single or multiple
objects. Holding the Shift key adds line
segments and fills them. Shift-clicking
selected items deselects them. 
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The Magic Wand tool (so named since it looks like a magic wand) is
unique in the fact that you do not drag and select with this tool; you
simply click. The Magic Wand tool creates a selection based on the
shift in brightness ranges within an image. If there is a definable shift in
the brightness of the pixels, it can be a very powerful tool for the selec-
tion of odd-shaped areas. To use the Magic Wand, click on the Magic
Wand Tool button on the Tools panel.

Using the Magic 
Wand Tool

Select Options for the Magic
Wand Tool

Double-click the Magic Wand tool
on the Tools panel.

◆ You can also click the Window
menu, and then click Magic
Wand to display the panel.

Click the Options button, and then
select the Show Stroke Options
and Show Transparency Options
(if necessary) to display them in
the Magic Wand panel.

◆ You can also click the double-
arrow next to the Magic Wand
title to display options.

Select the check box for the
attributes that you want the Magic
Wand to select. The options
include: Fill Color, Stroke Color,
Stroke Weight, Opacity, or
Blending Mode.

Enter a Tolerance value (0 to 255).
The higher the value, the more
information the Magic Wand tool
selects.

To select objects on all layers,
click the Options button, and then
select Use All Layers to check it.
Select it again to select objects
only on the current layer.

To reset all fields in the Magic
Wand panel, click the Options
button, and then click Reset.

6

5

4

3

2

1 1

2

3

4

5



Chapter 3 Working with Objects 87

Use the Magic Wand Tool

Select the Magic Wand tool on the
Tools panel.

Click an object area to make a
selection.

Depending on the options you
selected in the Magic Wand panel,
other objects with the same or
similar attributes (fill color, stroke
color, stroke weight, opacity, or
blending mode) are selected.

To add to the selection, hold down
the Shift key, and then click
another unselected object. 

To subtract from the selection,
hold down the Alt (Win) or Option
(Mac) key, and then click a
selected object.
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Selecting and grouping objects makes it easier to work with multiple
objects as if they were a single object. You can easily select, isolate,
cut, copy, paste, move, recolor, and transform a grouped object. You
can group all types of objects, yet still edit individual objects within the
group as needed without having to ungroup them first by using
Isolation Mode. Illustrator places a grouped object on the top level of
the top object in the group and uses the same selection color. If you no
longer need to group objects, you can ungroup them. 

Selecting and
Grouping Objects

Create a Group

Select the Selection tool on the
Tools panel.

Use a selection method to select
the objects that you want in the
group.

Click the Objects menu, and then
click Group.

◆ You can use the Group
command again to group
objects already in a group; this
is known as a nested group. 

Ungroup Objects

Select the Selection tool on the
Tools panel.

Select the grouped objects that
you want to ungroup.

Click the Objects menu, and then
click Ungroup.

◆ If you have nested groups
within an object, you can use
the Ungroup command again to
ungroup it. 
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Use Isolation Mode to Work
with Groups

Select the Selection tool on the
Tools panel.

Double-click a grouped object.

◆ You need to click the Isolate
Selected Object button on the
Control panel or select the
Double-click to Isolate check
box in General preferences.

A gray bar appears with the name
of the group at the top of the
document window. All objects
outside the group are dimmed out
and uneditable. The words
“Isolation Mode” also appear on
the Layers panel.

Edit individual objects or add new
objects to the group.

To exit Isolation Mode, click the
gray bar. 

4

3

2

1
1

2 3

4

Isolation Mode



90 Chapter 3

The Select menu provides a variety of powerful selection commands
for you to use in a document or artboard. In addition to the common
commands, such as All, Deselect, and Inverse, you can also select
objects whose attributes (including Appearance, Blending Modes, Fill &
Stroke, Opacity, and Stroke Color) are similar to the current or last
selection. For more selection power, you can select objects based on
the object type (including All on Same Layers, Direction Handles,
Bristle Brush Strokes, Clipping Masks, Stray Points, Text Objects).

Selecting Similar
Objects

Use the Select Menu to Select
Objects

Click the Select menu.

Select the command that you
want:

◆ All. Selects all objects in the
document.

◆ All on Active Artboard. Selects
all objects in the active
artboard.

◆ Deselect. Deselects all objects
in the document.

◆ Reselect. Reselects the most
recent selection.

◆ Inverse. Inverses the current
selection.

◆ Next Object Above. Selects the
next object above the current
selection.

◆ Next Object Below. Selects the
next object below the current
selection.
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Select Similar Objects or Object
Attributes

Select an object on which to base
the new selection or deselect all
objects to base the new selection
on the last selected object.

Click the Select menu, and then
point to Same or Object.

Choose the command that you
want to use to make a selection.

Select Objects in the Layers
Panel

Open the Layers panel.

Click the expand/collapse triangle
to display the layer that you want
to select.

Click the selection area on the
right side of the layer in the Layers
panel that has the object that you
want to select.

◆ You can also click the Select
menu, point to Object, and then
click All on Same Layers to
select all on a layer. 
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If you frequently select the same elements in a document, you can save
yourself some time by saving the selection with a name of your choice.
After you save a selection, the saved selection name appears as a
menu command at the bottom of the Select menu. When you need to
make the same selection, simply choose the command. When you no
longer use a saved selection, you can delete it. 

Saving and Editing
Selections

Save and Use a Selection

Make the selection that you want
to save.

Click the Select menu, and then
click Save Selection.

Enter a name for the selection.

Click OK.

Click the Select menu, and then
click the name of the saved
selection at the bottom of the
menu.

Edit a Saved Selection

Click the Select menu, and then
click Edit Selection.

Select the saved selection that
you want to rename or delete.

To delete a saved selection, click
Delete.

To rename a saved selection,
change the name in the Name box.

Click OK.5
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Moving an object or group of objects is very easy. The simplest way is
to drag the edge of an object in Outline or Preview view. If you want to
constrain the movement of the object in multiples of 45 degrees, then
use the Shift key as you drag. While you drag an object, Smart Guides
appear automatically to make it easier for you to align objects with
other objects. 

Moving Objects

Move an Object

Select the Selection tool on the
Tools panel.

Select one or more objects that
you want to move.

Drag the edge of an object.

◆ To constrain the movement of
the object to multiples of 45
degrees or the current angle in
General preferences, hold
down the Shift key as you drag. 

◆ If the path has a color fill,
appears in Preview mode, and
the Object Selection by Path
Only check box is deselected in
Selection & Anchor Display
preferences, you can also click
the fill to select the object.

3
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1

See Also
See “Using Smart Guides” on page 52
for more information on setting Smart
Guide preferences and using Smart
Guides.

Did You Know?
You can delete an object. Select the
object that you want to delete, and
then press Delete, or click the Edit
menu, and then click Clear. 
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Duplicating objects can be a powerful way of creating geometrical art-
work. You can duplicate one or more selected objects by dragging
them, using Arrow keys, copying to and pasting from the Clipboard, or
using the Offset Path command. When you copy objects to the
Clipboard, you can paste them on an artboard several different ways:
Paste, Paste in Front, Paste in Back, Paste in Place, or Paste on All
Artboards. The Offset Path command duplicates a path (along with fill
and stroke attributes) and places it on the artboard based on the offset
distance specified in the Offset Path dialog box. The duplicate path is
reshaped to fit around the original path.

Duplicating Objects

Duplicate or Copy Objects

Select the Selection tool on the
Tools panel.

◆ If the object is in a group,
select the Direct Selection tool
on the Tools panel.

Use any of the following methods:

◆ Same Document. Hold down Alt
(Win) or Option (Mac), and then
drag the edge or fill of the
object.

◆ Different Documents. Open the
documents side by side, and
then drag the edge or fill of the
object from one document to
another. 

◆ Copy/Paste from Clipboard.
Select the object, click the Edit
menu, and then click Copy.
Click in the target document or
artboard, click the Edit menu,
and then click Paste, Paste in
Front, Paste in Back, Paste in
Place, or Paste on All
Artboards.

◆ Keyboard. Select the object,
press Control (Win) or A
(Mac), and then use an Arrow
key to move the duplicated
object in the direction you
want. The duplicate object
moves away from the original
object based on the current
keyboard increment value in
General preferences.
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Duplicate Objects Using an
Offset

Select the Selection tool on the
Tools panel.

Select an object.

Click the Object menu, point to
Path, and then click Offset Path.

Enter the distance you want to
offset the duplicate path from the
original object.

Click the Joins list arrow, and then
select a bend style: Miter
(pointed), Round (circular), or
Bevel (square-cornered).

You can set a limit (1-16,000) to
determine when a mitered corner
changes into a beveled corner. A
low number creates a more
beveled corner, while a high
number creates a sharper corner.

Click OK.7
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Aligning and
Distributing Objects

Align or Distribute Objects

Select the Selection tool on the
Tools panel.

Select two or more objects to align
them or select three or more
objects to distribute them.

Select the Align panel or click
Align on the Control panel.

Click the Options button, and then
click Use Preview Bounds. A
checked option uses the object’s
stroke weight and any applied
effects when aligning or
distributing.

If you want to align objects along
the edges of the artboard, click the
Align To button on the Align or
Control panel, and then click Align
to Artboard. Objects are moved on
the artboard based on the
alignment or distribution command
to the closest edge (top and
bottom, or left and right). 

If you want to align objects to a
key object, click an object to make
it the key object (a thick blue
outline appears and the Align To
Key Object option is selected in
the Align and Control panel).

Use the alignment and distribution
buttons on the Align or Control
panel.
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In addition to using grids and guides to align objects to a specific point,
you can align a group of objects to each other. The Align panel buttons
make it easy to align two or more objects relative to each other or to
the page. To evenly align several objects to each other across the doc-
ument, either horizontally or vertically, select them and then choose a
distribution option. Before you select an align command, specify how
you want Illustrator to align the objects. You can align the objects in
relation to the document or to the selected objects. If you want to align
all the objects to another object, you can select and use a key object,
before you select an alignment option. 
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Align To button
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Transforming Objects

Transform an Object with the
Bounding Box

Click the View menu, and then
click Show Bounding Box to
display it.

Select the Selection tool on the
Tools panel.

Select one or more objects to
transform.

Use any of the following methods:

◆ Scale. Drag a corner handle to
scale along two axes; drag a
side handle to scale along one
axis; Shift-drag to scale
proportionally; hold down Alt
(Win) or Option (Mac), and then
drag to scale from the center.
Also hold down Shift to scale
from the center proportionally.

◆ Reflect. Drag a side handle all
the way across the object to
the other side. 

◆ Rotate. Point slightly outside a
corner handle (pointer changes
to a double arrow), and then
drag in a circular motion. 

To rotate an object 180
degrees, drag a corner handle
diagonally all the way across
the object.

To transform an object using exact
values or percentages, select the
Transform panel.
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The easiest way to transform an object is to use the bounding box. With
the bounding box, you can quickly scale (resize), reflect (mirror), and
rotate an object. However, you cannot copy an object or move the ref-
erence point. As you drag to transform an object, you can use keyboard
keys to alter the results of a transformation. Experiment with the differ-
ent options to create some new results.
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Using the Free
Transform Tool

Transform an Object with the
Free Transform Tool

Select the Selection tool on the
Tools panel.

Select one or more objects to
transform.

Select the Free Transform tool on
the Tools panel.

To adjust the reference point
(New!), point to the reference
point (blue point, cursor changes
to caret with a circle point), and
then drag it.

◆ Reset Reference Point. Double-
click the reference point.

To use Smart Guides as you
transform an object:

◆ Click the View menu, and then
click Smart Guides to display
them or select the Transform
Tools check box in Smart
Guides  preferences.

◆ As you drag to transform an
object, smart guides appear,
which you can use to align the
transformed object.

To distort an object, click the
Perspective Distort or Free Distort
button on the widget to toggle it on
(Highlighted icon). The Constrain
button also toggles off.
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The Free Transform tool allows you to rotate, scale (resize), reflect (mir-
ror image), shear (slant), or distort an object. In addition, you can apply
perspective and distortion to an object. When you select the Free
Transform tool, the free transform widget (New!) appears with button
options to constrain, free transform, perspective distort, and free distort.
As you drag to free transform an object, you can also use keyboard keys
to alter the results of a transformation. The selected object also has a
movable reference point (New!) to specify the center position of the
transformation. To help you align the results the way you want, you can
use Smart Guides to make it easier. Free Transform is also touch-
enabled (New!), which allows those with a touch screen device to
pinch and swipe for panning and zooming.
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Perspective distort

Perspective
distort results

Free Transform
widget
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To free transform an object, click
the Free Transform button on the
widget, and then use any of the
following methods:

◆ Scale. Drag a corner resize
handle to scale along two axes;
drag a side handle to scale
along one axis. 

To scale proportionally, click
the Constrain button on the
widget to toggle it on (Lock
icon) and then drag or Shift-
drag. To scale from the center,
hold down Alt (Win) or Option
(Mac), and then drag. Also hold
down Shift to scale from the
center proportionally.

◆ Reflect. Drag a side handle all
the way across the object to
the other side. 

◆ Rotate. Point slightly outside a
corner handle (pointer changes
to a double arrow), and then
drag in a circular motion. To
rotate in 45 degree increments,
Shift-drag.

To rotate an object 180
degrees, drag a corner handle
diagonally all the way across
the object.

◆ Shear. Drag a side handle and
then hold down Ctrl (Win) or
A (Mac) as you continue to
drag. To constrain the
movement, also press Shift. To
shear from the center, also
press Alt (Win) or Option (Mac). 

◆ Perspective. Drag a side
handle and then hold down
Ctrl+Alt+Shift (Win) or
A+Option+Shift (Mac) as you
continue to drag. 

◆ Distort. Drag a corner handle
and then hold down Ctrl (Win)
or A (Mac) as you continue to
drag.
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Distort

Distort
results

Shear
Shear results
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Rotating and Scaling
Objects

Rotate or Scale an Object

Select the Selection tool on the
Tools panel.

Select one or more objects to
transform.

Select the Rotate or Scale tool on
the Tools panel.

To move the reference point, click
a new point.

Use the appropriate method:

◆ Rotate. Drag in a circular
motion. To rotate in 45 degree
increments, Shift-drag. 

◆ Scale. Drag away from or
toward the object. Shift-drag to
scale proportionally; hold down
Alt (Win) or Option (Mac), and
then drag to scale from the
center. Also hold down Shift to
scale from the center
proportionally.

◆ Scale and Flip. Drag across the
entire object. 

◆ Scale and Copy. Hold down
Alt+Shift (Win) or Option+Shift
(Mac), and then drag. 

To rotate or scale an object using
exact values or percentages,
select the Transform panel.
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After you create an object, you can change its orientation by rotating it
or change its size by scaling it. For a freeform rotation, when you want
to rotate the object in other than 90 or 180 degree increments, you can
use the Rotate tool. To resize an object, either smaller or larger, you can
use the Scale tool. With either tool, you can transform the object from
its center or the reference point. To rotate or scale an object using
exact values or percentages, use the Transform panel, which is avail-
able on the Control panel or Window menu.
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Reflecting and
Shearing Objects

Reflect or Shear an Object

Select the Selection tool on the
Tools panel.

Select one or more objects to
transform.

Select the Reflect or Shear tool on
the Tools panel.

To move the reference point, click
a new point.

Use the appropriate method:

◆ Reflect. Click to establish a
reference point, and then click
again to establish the axis of
reflection.

◆ Shear. Drag away from the
object.

To reflect or shear an object using
exact values or percentages,
select the Transform panel.
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The Reflect and Shear tools on the Tools panel allow you to be creative
as you transform an object. The Reflect tool creates a mirror image of
an object, while the Shear tool creates a slanted image of an object. To
reflect or shear an object using exact values or percentages, open the
Transform panel, which is available on the Control panel or Window
menu.
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Applying Multiple
Transformations

Use the Transform Each Command

Select the Selection tool on the Tools
panel.

Select one or more objects to
transform.

Click the Object menu, point to
Transform, and then click Transform
Each.

Select the Preview check box to
view your object changes.

Do any of the following:

◆ Scale Horizontal or Vertical.
Specify to scale objects from their
reference point.

◆ Move Horizontal or Vertical.
Specify to move objects left or
right and up or down.

◆ Rotate Angle. Enter a rotate angle
or drag the dial. 

◆ Reflect X or Y. Select to create a
mirror reflection.

◆ Random. Select to apply random
transformations using the values
in the dialog box. 

◆ Scale Strokes & Effects. Select to
scale strokes and effects along
with objects. 

◆ Transform Objects. Select to
transform only objects. 

◆ Transform Patterns. Select to
transform only the object’s fill
pattern.

◆ Reference Point. Click a square to
change the reference point. 

Click OK or Copy (creates a copy and
applies the transformation).
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The Transform Each command allows you to transform—such as rotate,
reflect, scale, and shear—multiple objects relative to their reference
points instead of a single reference point. You can scale or move
objects, rotate objects by a specific angle, and create a mirror reflection
of the objects. If you want to create a unique effect, you can also have
Illustrator apply random transformations. You can also use the
Transform Effect command to create and modify similar effects. 
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Transformation
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Use the Transform Effect

Select the Selection tool on the
Tools panel.

Select one or more objects to
transform.

Click the Effect menu, point to
Distort & Transform, and then click
Transform.

Select the Preview check box to
view your object changes.

Do any of the following:

◆ Scale Horizontal or Vertical.
Specify to scale objects from
their reference point.

◆ Move Horizontal or Vertical.
Specify to move objects left or
right and up or down.

◆ Rotate Angle. Enter a rotate
angle or drag the dial. 

◆ Reflect X or Y. Select to create
a mirror reflection.

◆ Random. Select to apply
random transformations using
the values in the dialog box. 

◆ Scale Strokes & Effects. Select
to scale strokes and effects
along with objects. 

◆ Transform Objects. Select to
transform only objects. 

◆ Transform Patterns. Select to
transform only the object’s fill
pattern.

◆ Reference Point. Click a square
to change the reference point. 

◆ Copies. Enter the number of
copies you want.

Click OK.

To edit the transformation, select
the object, and then click
Transform on the Appearance
panel.
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Repeating a Transformation
The Transform Again command allows you to quickly repeat the last
transformation with the last-used values on a selected object. To use
the command, transform and select an object or group, click the
Object menu, point to Transform, and then click Transform Again or
press Ctrl+D (Win) or A+D (Mac).

For Your Information

2

Transformation
effect

5
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Reshaping Objects
with Envelopes

Distort Objects with an Envelope

Select the Selection tool on the
Tools panel.

Select one or more objects to
reshape.

Click the Object menu, point to
Envelope Distort, and then click
one of the following:

◆ Make With Warp. Uses a
preset warp shape.

◆ Make with Mesh. Uses a
rectangle grid.

◆ Make With Top Object. Uses an
object as the shape of the
envelope. The object needs to
be at the top of the stacking
order. 

Specify the options you want for
the envelope type; select the
Preview check box to view your
changes on the selected object.

Click OK.

Do any of the following:

◆ Reshape. Select the Selection
or Mesh tool, and then drag
any anchor points. 

◆ Delete Anchor Points. For a
mesh grid, select the Selection
or Mesh tool, select an anchor
point, and then press Delete.

◆ Add Anchor Points. For mesh
grid, select the Mesh tool, and
then click on the grid. 
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Envelopes are objects you can use to reshape other objects, except
graphs, guides, or linked objects. You can use one of the built-in
envelopes or create your own out of an existing object. The built-in
envelopes use warp shapes or a mesh grid as the object. After you
apply an envelope, you can edit the original object or the envelope
(anchor points), separately, using the Selection and Mesh tools on the
Tools panel. In addition, you can specify envelope options to determine
how objects are distorted to fit the envelope.
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Mesh grid
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Set Envelope Options

Click the Object menu, point to
Envelope Distort, and then click
Envelope Options.

To set options for an object, select
one or more objects to reshape.

Do any of the following:

◆ Anti-Alias. Select to smooth
rasterized images when
distorted with an envelope.

◆ Preserve Shape Using. Select
the option to specify how to
rasterized images preserve
their shape when distorted by
nonrectangular envelopes. Use
a clipping mask on the raster
image or apply an alpha
channel (transparency) to the
raster image.

◆ Fidelity. Drag the slider or enter
a number to specify how you
want to fit the envelope mold. 

◆ Distort Appearance. Select to
distort appearance attributes
along with an object’s shape.

◆ Distort Linear Gradient Fills.
Select to distort linear
gradients along with an object’s
shape.

◆ Distort Pattern Fills. Select to
distort pattern fills along with
an object’s shape. 

◆ Preview. Select to view your
changes in the Document
window. 

Click OK.4
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Using the Transform
Panel

Transform an Object with the
Transform Panel

Select the Selection tool on the
Tools panel.

Select one or more objects to
transform.

Select the Transform panel.

Specify exact values or percent-
ages for any of the following: 

◆ X & Y Coordinates. Enter X and
Y values, which refer to the
selected reference point; click
a white square to change it. 

◆ Width (W) & Height (H). Enter
width and height values. Use
the Lock icon to constrain
proportions.

◆ Rotate Angle. Enter a rotate
angle.

◆ Shear Angle. Enter a shear
angle.

◆ Align to Pixel Grid. Select to
pixel-align individual object to
the pixel grid. 

◆ Scale Strokes & Effects. Select
to scale strokes and effects
along with objects. 

◆ Click the Options button to
select additional options. 
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The easiest way to transform an object is to use the bounding box or
the Free Transform tool. You can quickly drag to transform an object.
However, if you want to transform an object to an exact size or dimen-
sion, you can do it with the Transform panel. With the Transform panel,
you can specify exact values or  percentage for X & Y coordinates,
width & height, rotate angle, and shear angle as well as other options
to align to the pixel grid, and scale strokes & effects.

2

3 Options button
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Index

A
accented edges effects, 311
accounts

Creative Cloud, 23, 468, 506
actions

Actions panel, 368–369
adding commands to, 374
adding stops to, 372
batch file processing, 376–377
building new, 370
built-in scripts, 378
controlling playback of, 371
deleting commands from, 375
inserting a non-recordable command in

an Action, 373
order of commands in, changing, 374
recording, 370
running actions within actions, 370
saving, 369
scripts, 378–379

activation, 2
active documents, 21
active windows, 20
Adobe.com. See Adobe Web site, Adobe

ID, Adobe Creative Cloud
Adobe Acrobat Reader, 438
Adobe Bridge

automating tasks in, 499
browsing documents with, 16
Camera Raw feature, 490–493
color settings, 109
components of, 487
description of, 486
editing images in, 498
Get Photos from Camera command, 489
opening documents with, 16–17, 488
placing graphics from, 270-271
preferences, setting, 496–497

revealing documents in, 16
Web Photo Gallery creation, 495
working with images using, 17, 494–495

Adobe Creative Cloud, 485-486
installing Illustrator, using, 2-3
managing account, 468, 506
sign in and out, 23, 468, 506
starting Illustrator, using, 4-5
syncing settings on, 468-469

Adobe Dreamweaver, 426-427, 432-433
Adobe Edge Animate

saving SVG for, 433
Adobe Exchange

Extension Manager, using with, 504, 505
panel, 3, 486, 505
resources, accessing, 3, 486, 505
selecting plug-ins, 477

Adobe ExtendScript Toolkit, 486, 501
Adobe Extension Manager, 433, 486, 504,

505
Adobe Flex File 

opening documents as, 14-15, 268
placing images, 18, 269

Adobe ID
installing Illustrator, using, 2-3
Kuler web site, 122-123
profile, 23
sign in and out (Creative Cloud), 23, 486,

506
starting Illustrator, using, 4-5
syncing settings (Creative Cloud), 

468-469
Adobe Idea File (IDEA), 14-15
Adobe Media Encoder, 502-503
Adobe Mini Bridge, 500
Adobe PDF Presets command (Edit menu),

436
Adobe Product Improvement Program, 25
Adobe SVG Viewer, 432-433
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Adobe Updater, 23
Adobe Web site

Adobe applications, downloading, 3
Adobe Exchange, 3, 505
Community Help, 24

Adobe World-Ready Composer (WRC), 256-
257, 473

advanced print options, 404–405
Advanced tab (File Info dialog box), 409
alignment

anchor points, 178–179
objects, 96
paragraphs, 252
pixel grid, 67
slices, 459
stroke, 138

All Objects command (Select menu), 90
All Objects in Active Artboard command

(Select menu), 90
anchor points

adding new, 176–177
alignment, 178–179
average, 173
Convert Anchor Point tool, 175
converting, 174–175
deleting, 177
direction lines, 172
endpoints, 179
highlighting, 172
moving, 172–173
paths and, 65
preferences, 172
selecting with Direct Selection tool, 84
showing and hiding, 65
smooth points, converting to corner

points, 174
anchors, 471
Android (Media Encoder), 502-503
anti-aliasing, 251, 466
Appearance of Black preferences, 482
Appearance panel, 288–289
Apple devices (Media Encoder), 502-503
Arc tool, 72
arcs, drawing, 72
area graphs, 382-383
Area Type tool, 222, 225-226

converting, 227

arranging
documents, 20
layers, 208–209
slices, 458–459

arrowheads, stroke, 140-141
art brushes, 334–335
Artboard tool

artboard creation, 36
Artboard Options button, 37
multiple artboards, 38

artboards
within artboards, 36
aspect ratio, 37
centerpoints, 37
deleting, 38
display options, 39
duplicating, 36
exiting editing mode, 36
landscape/portrait orientation, 37
moving, 38
multiple, working with, 38
navigating within, 36
presets, 36
previewing, 38
resizing, 38
rotating, 38
size, 37
switching between, 19, 39
video safe areas, 37
X and Y positioning, 37

artwork, inserting in documents, 18
Asian languages 

support, 256-257, 472-473
Assign Profile command (Edit menu), 110
attributes

appearance, 288–289
stroke, 138–141

Audio Data tab (File Info dialog box), 408
auto slices, 452
AutoCAD File format, 415 

exporting as, 422-423
opening with, 14, 268
placing with 18, 269

automatic corner generation, pattern 
brushes, 336–337
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B
bar graphs, 382-383
baseline type, character, 248-249
batch file processing, 376–377
Batch Rename command, 499
Behance (web site), sharing on, 6, 19, 464
bend styles, 95
bevel bend style, 95
bevel joins, 139
bitmap, exporting documents as, 416
black appearance options, 482
bleed

bleed print option, 399
document creation, 34

Blend command (Objects menu), 151–152
Blend tool, 153
blends

blending fill colors, 150
changing and applying blend options,

152
creating automatically, 151
creating with Blend tool, 153
making and releasing blend objects, 151
objects, modifying, 154
opacity, 155
transformation, 154
transparency settings, 156

Bloat tool, 342
Blob Brush tool

brush options, setting, 189
merging paths with, 188

blur effects, 308-309
BMP format, 415
bold font, 238-239
Bounding Box command (View menu),

324–325
Bridge (Adobe)

automating tasks in, 499
browsing documents with, 16
Camera Raw feature, 490–493
color settings, 109
components of, 487
description of, 486
editing images in, 498
Get Photos from Camera command, 489
Mini Bridge, 500
opening documents with, 16–17, 488

placing graphics from, 270-271
preferences, setting, 496–497
revealing documents in, 16
Web Photo Gallery creation, 495
working with images using, 17, 494–495

Bristle brushes, 338-339
creating and editing, 338-339

Browse in Bridge command (File menu),
16–17, 270-271

browser
preview in (Save for Web), 463

brushes
art, 334–335
Blob Brush tool, 189
Bristle, 338-339
Brushes panel, 327
calligraphic, 332–333
deleting, 340
library, saving, 341
Paintbrush tool, 328–329
pattern, 336–337
scatter, 330–331
strokes, removing, 340

Brushes panel, 327
built-in scripts, actions, 378

C
calligraphic brushes, 332–333
Camera Data tab (File Info dialog box), 408
Camera Raw feature, 486, 490–493
canvas (user interface), 479
caps, 139
case, text, 393
Cascading Style Sheet. See CSS
Categories tab (File Info dialog box), 408
center mark, 39
centerpoints, 37
Character panel, 238-251

changing fonts, 238-239
changing font size, 242
finding and changing fonts, 240-241
formatting type, 250
touching up type, 248-249

Character Styles panel, 258-259
Check Spelling command (Edit menu), 388
circles, drawing, 68
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clean up unneeded elements, 385
clearing

guides, 51
objects, 93

clipping masks
creating, 194
creating for groups or layers, 195
editing, 196
masked object, editing in Isolation

Mode, 197
release objects from, 195

clipping sets, 197
Close button, 28
Close command (File menu), 28
closed paths, 65
closing

documents, 28
Illustrator, 28
panels, 8-9

CMYK (Cyan, Magenta, Yellow and Black)
color mode, 30, 111, 115

collapsing panels, 8-9
Color Guide panel

applying color with, 128–129
color groups, 129
harmony rules, variations based on, 129
variation options, selecting, 127
variation types, displaying, 127

color management print options, 406
color modes. See also colors

changing, 112
CMYK, 30, 111, 115
document creation, 30
Grayscale, 30, 114
RGB, 30, 111, 114
switching between, 111
working with, 111

Color panel
Color sliders, 114
working with, 114–115

colored paper simulation, 35
colors. See also Color Guide panel; color

modes; Swatches panel
applying to objects, fills, or stroke, 113,

136-137
applying with Eyedropper tool, 144–145
Color Guide Panel, 127–129

Color panel, 114–115
color profiles, changing or removing, 109
color settings, changing, 108–109
converting to grayscale, 125
crop mark registration color, 56-57
finding, 115-116
gamut warning icon, 115
global, 124–126
grayscale images, 125
grid colors transparency settings, 35
grids, 54
group, creating, 118-119
guides, 50, 53
hue, 115
inverting, 126
Kuler panel, 122–123
Live Color feature, 130–131
luminosity, 115
nonglobal, 124–126
proofing, 132-133
replacing, 124–125
saturation, 115
selecting, 115
soft proof, 132-133
Swatches panel, 116–121
themes, 122–123
type, 266
ungroup, 119
view box color, 44
Web-safe, 115

column graphs, 382-383
combining

slices, 460
commands

adding to actions, 374
basic description of, 6-7
deleting from actions, 375
Panel Options menu, 11

Community Help site, 24
compound paths

creating, 192
releasing, 193
reversing object's fill in, 193

condensed font, 238-239
Constrain Angle general preference, 466
Control panel

anchor points, converting, 175
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basic description of, 13
splitting paths using, 186-187
tools in, 6-7

Convert Anchor Point tool, 175
Convert to Shape command (Effect menu),

294
convert to shape effects, 294
converting anchor points, 174–175
Copy command (Edit menu), 235
copying text, 234–235
corner generation (automatic), pattern

brushes, 336–337
corner points, 174
Corner Radius general preference, 466
Create New Action button (Actions panel),

369
Create New Set button (Actions panel), 369
Creative Cloud (Adobe). See Adobe

Creative Cloud
crop marks

creating, 56-57
deleting, 56
general preferences, 467
registration color, 56
trim marks, editable, 57

cross hairs, 39
Crystallize tool, 342
CSS (Cascading Style Sheets)

CSS Properties panel, 426
exporting as CSS file, 427
file formats, 415
generating CSS, 426
saving as SVG with, 432-433

CSS Properties panel, 426
cursor preferences, 466
curved segments, 173
curves, drawing, 171
custom dictionaries, spell checking, 389
Cut command (Edit menu), 235
cutout effects, 310

D
dashed stroke, 140
data graphs, 382-383
data sets

creating, 380–381
deleting, 380–381
renaming, 381

data variables, 380–381
deactivate Illustrator, 22
Delete button (Actions panel), 369
deleting

anchor points, 177
artboards, 38
brushes, 340
commands from actions, 375
crop marks, 56-57
data sets, 380–381
files, 14
graphic styles, 287
layers, 205
objects, 93
selections, 92
slices, 454
symbols, 347
workspaces, 61

Description tab (File Info dialog box), 408
Deselect command (Select menu), 90
dialogs

Reset All Warning Dialogs, 467
DICOM tab (File Info dialog box), 409
dictionaries, spell checking, 389
diffuse glow effects, 311
Direct Selection tool

anchor points, adding new, 176
anchor points or segments, moving, 173
deleting anchor points using, 177
end points, connecting, 179
selecting anchor points and segments

with, 84
showing/hiding direction lines, 65
understanding selections, 82

direction lines
anchor points, 172
showing and hiding, 65

Discard White Overprint in Output, 34-35,
404-405

Distort & Transform command (Effect
menu), 102, 301

distributing
objects, 96
slices, 459

dithering, 447
dividing 

paths, 185
slices, 460
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drawing mode, 66
behind, 66
normal, 66
inside, 66

DOC format, 231
docking

documents, 21
panels, 10

Document Color Mode command (File
menu), 112, 394

Document Info panel, 410
Document Setup command (File menu), 34,

159
Document window, 6-7
documents

active, 21
arranging, 20
bleed and view options settings, 34
browsing with Adobe Bridge, 16
closing, 28
color modes, 30
creating

from scratch, 30
from templates, 32–33
using presets, 31

docking/undocking, 21
exporting

as bitmap, 416
Export command, 414
export file formats, 415
as Flash Movie, 424–425
to Photoshop, 420-421
with presets, 436
as TIFF format, 417

file information, inserting, 408–409
finding and replacing text and elements

in, 390–391
grid pattern, 21
inserting images in, 18
language options, 35, 256
linking, 18
measurement units, 34
opening

with Adobe Bridge, 16–17
existing documents, 14
recently opened, 15

printing, 394

revealing in Adobe Bridge, 16
rulers, 48–49
saving, 26–27

as EPS format, 430–431
as Microsoft Office, 434
as PDF format, 428–429
as SVG format, 432-433
as template, 435
for the Web, 438–439

setting up, 34–35
spell checking, 388–389
switching between, 20
tabbed, 20
templates, 18
transparency settings, 34–35
type options settings, 35
view size, 19
viewing information in, 19
views, 40–43
windows, 20–21
working with multiple, 20–21

DOCX format, 231
double quotes, 35
drawing

arcs, 72
circles, 68
curves, 171
ellipses, 68
line segments, 71
with Pencil tool, 314–315
polygons, 70, 170
rectangle grids, 74
rectangles, 69
spirals, 72–73
stars, 70

drawing tablets, using, 484
Dreamweaver (Adobe). See Adobe

Dreamweaver
drop shadow effects, 297
duplicating

artboards, 36
color in Swatches panel, 117
graphic styles, 285
layers, 210
objects, 94–95
slices, 454, 460
symbols, 348
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E
Edit Colors command (Edit menu), 126, 150
Edit Custom Dictionary command (Edit

menu), 389
Edit menu commands

Adobe PDF Presets, 436
Assign Profile, 110
Check Spelling, 388
Color Settings, 108
Copy, 235
Cut, 235
Edit Colors, 126, 150
Edit Custom Dictionary, 389
Find and Replace, 390–391
Paste, 234–235
Paste in Back, 235
Paste in Front, 235
Print Presets, 395
Redo, 59
Transparency Flattener Presets, 405
Undo, 59

Edit Selection command (Select menu), 92
Edit View command (View menu), 40
editing

blend objects, 154
clipping masks, 196
color in Swatches panel, 117
colors with Live Color, 130–131
gradients, 164
graphic styles, 286
images in Adobe Bridge, 498
paths within clipping sets, 197
patterns, 148
selections, 92
symbols, 349

Edge Animate (Adobe). See Adobe Edge
Animate

Effect menu commands
Convert to Shape, 294
Crop Marks, 56
Distort & Transform, 102
Effect Gallery, 304–307
Stylize, 295

effects
accented edges, 311
applying multiple, 306

blur, 308-309
controlling with selections, 307
convert to shape, 294
cutout, 310
diffuse glow, 311
distort, 301
drop shadow, 297
dry brush, 310
Fresco, 310
gaussian blur, 308-309
glass, 311
glowing edges, 311
grain, 312
graphic pen, 312
Illustrator, 292–293
inner glow, 296–297
mosaic tiles, 312
note paper, 311
outer glow, 296–297
panel knife, 310
Photoshop Effect Gallery, 304–305
plastic wrap, 312
previewing, 292
raster graphics, 302
scribble, 295
spatter, 312
stained glass, 312
stamp, 311
text, 230
transform, 301
3D, 298–299
vector objects, 303
warp, 300

Ellipse tool, 68
ellipses, drawing, 68
embedding

graphics, 269, 272–277
endpoints, 179
Enhanced Metafile format, 415
Envelopes, reshaping with, 104-105
EPS format, 27, 409, 430–431
Eraser tool, 182
erasing path parts, 182
exiting Illustrator, 28
Expand button (Pathfinder panel), 190
Expand command (Objects menu), 

160-161
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expanding
gradients, 160-161
panels, 8-9
patterns, 149

ExportDocsAsFlash, script, 378–379
exporting

documents
as bitmap, 416
as CSS, 426-427
Export command, 414
as Flash Movie, 424–425
as JPEG, 418-419
to Photoshop, 420-421
as PNG, 418-419
with presets, 436
as TIFF format, 417

export file formats, 415
ExtendScript Toolkit (Adobe). See Adobe

ExtendScript Toolkit
Extension Manager (Adobe). See Adobe

Extension Manager
extensions, downloading and installing

with Adobe Exchange, 3, 505
with Adobe Extension manager, 504

Extensions command (Window menu),
122–123

Eyedropper tool
applying colors and attributes with,

144–145
color attributes, changing, 145
Save for Web tool, 440-441

F
families, font, 238-239
File Handling & Clipboard preferences, 

480-481
File Info command (File menu), 408
file information, inserting into documents,

408–409
File menu commands

Browse in Bridge, 16–17, 270-271
Close command, 28
Device Center, 41
Document Color Mode, 112, 394
Document Setup, 34, 159
File Info, 408
New, 30–31
New From Template, 32

Open, 14, 268
Open Recent, 15
Open With, 270
Place, 18, 269, 272, 276
Print, 394, 396
Return to Adobe Illustrator, 16
Revert, 26
Save, 26
Save a Copy, 27
Save As, 27, 33
Save for Web, 438–441, 442-443
Scripts, 378–379

files
deleting, 14
formats (Save for Web), 438-443
images, optimizing to file size (Save for

Web), 451
saving actions as, 369

fills
applying color to, 113, 128, 136-137
blending fill colors, 150
patterns as, 146–149

finding
fonts, 240-241
for help information, 25

Find and Replace command (Edit menu),
390–391

Find Font command, 392
Fire/Nook HD device, 31
Fit All In Window command (View menu),

46
Fit Artboard In Window command (View

menu), 46
Flare tool, 69
Flash Builder, 31
Flash format, SWF, 415, 424-425
Flash Movie, exporting documents as,

424–425
Flash (Media Encoder), 502-503
Flattener Preview command (Window

menu), 41, 405
flattening layers, 216
flattening object transparency, 158
fonts

bold, 238-239
condensed, 238-239
families and styles, 238-239
Find Font command, 241, 392
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finding, 240-241
italic, 238-239
OpenType fonts, 262
replacing, 241
reusing recent, 238-239
size, 242

formatting type, 250
Freehand format, 14
Free Transform tool, 98–99

Transform panel, 106
free transform widget, 98-99
Fresco effects, 310
full screen mode, 45
FXG format, 14, 18, 268-269

G
gamut warning icon, 115
Galaxy S III device, 31
Gap options, 326
gaussian blur effects, 308-309
General preferences, 466
gestures

touch-enabled features, 62, 98-99
Get Photos from Camera command

(Adobe), 489
GIF documents, optimizing, 446–447
GIF format, 409
glass effects, 311
global colors, 124–126
glowing edges effects, 311
glyphs, 261
Go to Bridge button, 16–17
GPS Data tab (File Info dialog box), 408
Gradient tool, 165
gradients

applying to objects, 160-161
creating, 163
editing, 164
expanding, 160-161
fill, 160
Gradient Annotator, 165
Gradient tool, 165
libraries, using, 162
linear type, 163
mesh, 104-105, 166-167
radial type, 163
stroke, 161

grain effects, 312
graphic pen effects, 312
graphics

embedded, 272–277
linked, 272–277
linking, 272–277
mosaic, 290
opening graphic images, 268
placing, 269-272
print options, 400
raster

interpolation and, 64
tracing, 278–282
understanding raster graphics, 64

styles
applying, 283
breaking links to, 287
creating, 284
deleting, 287
duplicating, 285
editing, 286

graphs, 382-383
add designs, 384
create and format, 382-383

Grayscale color mode, 30, 114
grayscale images, 125
grid colors transparency settings, 35
grid patterns, 21
Grid, Perspective

adjusting, 79
copying, 80
customizing, 81
drawing, 78
moving, 80
objects, adding, 80
resizing, 80
text, adding, 80

unembedded graphics, 274–275
grid, pixel aligned, 67
grid size transparency setting, 34
grids. See also guides

color, 54
displaying in back of artwork, 54
Polar Grid tool, 75
preferences, 54
Rectangle Grid tool, 74
showing and hiding, 54



528

grids (continued)
Snap to Grid command, 54
styles, 54
subdivisions, 54
Transparency, 159

Group command (Objects menu), 88
Group Selection tool, 82
grouping objects, 88–89
groups

creating clipping masks for, 195
colors, creating in the Swatches panel,

118-119
guides. See also grids

clearing, 51
color, 50
converting vector objects to, 51
creating, 51
locking, 50
preferences, 50
ruler, 49
showing and hiding, 50
smart guides

object transformation, 99
preferences, 53
turning on/off, 52
working with, 52–53

snap to point, 50
style, 50
switching, 51

H
Hand tool

moving elements around with, 55
quick access to, 55
Save for Web tool, 440-441

handles, 471
hanging indents, 253
hardware, Illustrator system 

requirements, 3
Help menu commands

Adobe Product Improvement Program,
25

Illustrator Help, 24–25
Updates, 23

help options
Community Help site, 24
searching topics, 25

Hide Edges command (View menu), 65
Hide Panels command (Window menu), 20
hiding

anchor points, 65
direction lines, 65
grids, 54
guides, 50
layers, 212
panels, 10, 45
rulers, 49
slices, 454–455
Transparency grid, 159

HiDPI, 2, 47
highlighting anchor points, 172
histograms, 493
History tab (File Info dialog box), 409
HSB color slider (Color panel), 114
HTML text, adding to slices, 456
hue, 115
hyphenation, 255, 476
hyphenation preferences, 476

I
icons, collapsing and expanding panel sets

between icons and panels, 11
Illustrator Help command (Help menu),

24–25
Illustrator tab (File Info dialog box), 409
images

inserting in documents, 18
replacing, 18
working with images using Bridge, 17

ImageTracing, script, 378–379
Image Tracing options, 278-281
Image Trace panel, 278-281
importing text, 231
indentation

hanging indents, 253
paragraphs, 253

Indian languages 
support, 256-257, 472-473

Info panel
color fill and stroke information, 58
uses for, 58

inner glow effects, 296–297
iPad/iPad Mini device, 31

Media Encoder, 502-503
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IPTC tab (File Info dialog box), 408
IPTC Extension tab (File Info dialog box),

408
iPhone device, 31

Media Encoder, 502-503
installing Illustrator

in Macintosh, 3
in Windows, 2

Internet, checking for updates from, 22
interpolation, 64
Inverse command (Select menu), 90
inverting colors, 126
IPTC tab (File Info dialog box), 408
Isolation Mode, 197
italic font, 238-239

J
JavaScript, SVG, 432-433
joining anchor endpoints, 179
joins, 139
JPEG documents, optimizing, 444–445
JPEG format, 409, 415

exporting as, 418-419
justification options, 263

K
kerning type, 244
Keyboard Increment general preference,

466
keyboard shortcuts, 483
Kindle Fire HD device, 31
Knife tool, 185
Knockout Group option, 156
Kuler

MyKuler, 122-123
panel, 122-123
web site, 122

L
landscape/portrait orientation, 37
language options 

document creation, 35, 256
preferences, 256-257, 472-473

Lasso tool
selecting objects with, 85
understanding selections, 82

layers. See also Layers panel
arranging, 208–209
creating clipping masks for, 195
creating top level layers, 202–203
deleting, 205
deselecting, 204
duplicating, 210
flattening, 216
hiding, 212
locking, 211
merging, 213
moving, 208–209
moving objects to, 214–215
naming, 203
outlines, viewing, 219
Paste Remembers Layers, 214
releasing objects to, 215
reverse order, 208
selecting, 204
selecting objects with, 206–207
showing and hiding, 212
sublayers, 202–203
template, creating, 218

Layers panel. See also layers
accessing, 200
components of, 200
locating objects in, 217
options, setting, 201

layouts, workspace, 60
leading text, 243
libraries

brushes, saving, 341
gradients, 162

ligature, 263
line graphs, 382-383
Line Segment tool, 71
line segments, drawing, 71
linear gradient type, 163
linked graphics, 272–277
linking

documents, 18
graphics, 272-273
slices, 455

Liquify tools, 345
Live Color

applying color groups to objects with,
130–131
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Live Paint (continued)
editing colors with, 130–131

Live Paint Bucket tool
paint fills, 320
preferences, setting, 319
selecting options to paint fills or strokes

with, 318
stroke edges, changing, 321

Live Paint Groups
adding paths to, 325
converting traced objects to, 317
creating, 316–317
Gap options, 326
reshaping or moving paths in, 324–325

Live Paint Selection tool, 322–323
locking, 211
guides, 50
layers, 213

lossy compression, 447
lowercase text, 393
luminosity, 115

M
Macintosh

Illustrator system requirements, 3
installing Illustrator in, 3
starting Illustrator in, 5

Macintosh PICT format, 415
Magic Wand tool

selecting objects with, 86–87
understanding selections, 82

marks print options, 398–399
Measure tool, 58
measurement

distance between objects, measuring, 58
measurement units, document creation,

34
Media Encoder (Adobe). See Adobe Media

Encoder
menus, 6-7
merging

layers, 213
paths, 188–189

mesh, 104-105, 166-167 
metadata, 408-409, 494
Microsoft Office, saving documents as, 434
Middle East & South Asian Every-line

Composer, 256-257, 473

Middle East & South Asian Single-line
Composer, 256-257, 473

Mini Bridge (Adobe). See Adobe Mini
Bridge

miter bend style, 95
miter joins, 139
Mobile SWF tab (File Info dialog box), 408
mode, drawing, 66
mosaic tiles effects, 290, 312
Move tool, 52
moving

anchor points, 172–173
artboards, 38
document elements with Hand tool, 55
layers, 208–209
objects, 93
objects to layers, 214–215
segments, 172–173
slices, 458
text, 229, 234–235
between tools, 55

N
naming

layers, 203
selections, 92
workspaces, 60

navigation
artboards, 39
within artboards, 36

Navigator panel
customizing, 44
view area, 43
view box color, 44
view size, 42

New command (File menu), 30–31
New From Template command (File menu),

32
New View command (View menu), 40
Next Object Above command (Select

menu), 90
Next Object Below command (Select

menu), 90
9-slice scaling, 362-363
Nook HD device, 31
nonglobal colors, 124–126
non-recordable command in an Action, 373
normal screen mode, 45
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note paper effects, 311

O
objects

alignment, 96
applying color to, 113, 128, 136-137
clearing, 93
deleting, 93
distributing, 96
duplicating, 94–95
grouping, 88–89
measuring distance between, 58
moving, 93
moving to layers, 214–215
Perspective Grid

adjusting, 79
copying, 80
customizing, 81
drawing, 78
moving, 80
objects, adding, 80
resizing, 80
text, adding, 80

pixel grid, aligned, 67
reflecting, 97, 101
rotating, 97–98, 100
scaling, 97, 100
selecting

with Lasso tool, 85
with Magic Wand tool, 86–87
similar objects, 90–91
using Direction Selection tool, 84
using Select menu, 90–91
using Selection tool, 83

Shape Builder tool, 76-77
transforming, 97–99

Objects menu commands
Blend, 151–152
Clipping Mask, 194
Compound Path, 192
Expand, 160-161
Group, 88
Text Wrap, 264
Transform, 102
Ungroup, 88

offsetting paths, 95, 187
opacity, blends, 155

opacity mask, transparency, 157
Open command (File menu), 14, 268
open paths, 65, 177
Open Recent command (File menu), 15
OpenType fonts, 262
Open With command (File menu), 270
opening

documents
with Adobe Bridge, 16–17
existing documents, 14
recently opened, 15

graphic images, 268
panels, 8-9

optimizing
images to file size (Save for Web), 451

Origin tab (File Info dialog box), 409
outer flow effects, 296–297
Outline view, 40–41
outlines, 265
outlines, viewing layers as, 219
output print options, 402–403
overflow, text, 236–237
Overprint Preview command (View menu),

41, 401

P
Packaging

packaging a document, 412-413
viewing a package folder, 412-413

Paintbrush tool, 181
painting

art brushes, 334–335
Brushes panel, 327
calligraphic brushes, 332–333
Live Paint Bucket tool, 318–321
Live Paint Groups

adding paths to, 325
converting traced objects to, 317
creating, 316–317
Gap options, 326
reshaping or moving paths in,

324–325
Live Paint Selection tool, 322–323

Paintbrush tool, 328–329
pattern brushes, 336–337
scatter brushes, 330–331

panel knife effects, 310
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Panel Options menu, 8-11
panels

adding, 10
closing, 8-9
collapsing, 8-9, 11
displaying hidden, 45
docking/undocking, 10
expanding, 8-9, 11
hiding, 10, 45
opening, 8-9
Panel Options menu, 11
resizing, 8-9
sets, collapsing and expanding between

icons and panels, 11
subtracting, 10

paragraphs
alignment, 252
indentation, 253
spacing, 253

Paragraph panel, 252-253, 255
Paragraph Styles panel, 258-259
Paste command (Edit menu), 234–235
Paste in Back command (Edit menu), 235
Paste in Front command (Edit menu), 235
Pathfinder commands, 191
Pathfinder panel, 190-191
paths

anchor points and, 65
clean up unneeded elements, 385
clipping mask, 194–197
closed, 65
compound, 192–193
convert mesh object to, 174
convert strokes to compound, 192
dividing, 185
erasing parts of, 182, 314
join, 179
merging, 188–189
offsetting, 95, 187
open, 65, 177
outline stroke, 181
reshaping, 180–181
segments and, 65
Shape Mode command, 190
shape of, changing, 65
simplify, 184
smoothing, 183
splitting, 186–187

splitting into grid, 187
pattern brushes, 336–337
patterns

applying to objects, 149
creating, 146-147
editing, 148
expanding, 149
as fills, 149
as strokes, 149

PDF format, 27 
saving as, 409, 428–429
SaveDocsAsPDF, script, 378–379

Pen tool
anchor points, adding, 177
drawing curves with, 171
drawing polygons with, 170

Pencil tool
preferences, 315
reshaping paths with, 181
working with, 314–315

Perspective Grid
adjusting, 79
copying, 80
customizing, 81
drawing, 78
moving, 80
objects, adding, 80
resizing, 80
text, adding, 80

Photoshop Effect Gallery, 304–305
Photoshop, exporting to, 420-421
Photoshop format, 415
pie graphs, 382-383
pixel grid, align, 30, 67, 364
Pixel Preview command (View menu), 41
pixels, 37
Place command (File menu), 18, 269, 272,

276
placing graphics, 18, 269–271
plastic wrap effects, 312
Play button (Actions panel), 369
playback, action, 371
plug-ins

downloading and installing (Adobe
Exchange), 3, 505

preferences, 477
PNG format, 409, 415

exporting as, 418-419



Index 533

PNG-8 document, 448–449
PNG-24 document, 450
point type, 222-223

converting, 227
creating, 223-224

point/pica size, 48
points, anchor

adding new, 176–177
alignment, 178–179
average, 173
Convert Anchor Point tool, 175
converting, 174–175
deleting, 177
direction lines, 172
endpoints, 179
highlighting, 172
moving, 172–173
paths and, 65
preferences, 172
selecting with Direct Selection tool, 84
showing and hiding, 65
smooth points, converting to corner

points, 174
Polar Grid tool, 75
Polygon tool, 70
polygons, drawing, 70, 170
portrait/landscape orientation, 37
preferences

Adobe Bridge, 496–497
anchor points, 172
Appearance of Black, 482
cursor, 466
File Handling & Clipboard, 480-481
General, 466
grids, 54
guide, 50
hyphenation, 476
keyboard shortcut, 483
Live Paint Bucket tool, 319
Pencil tool, 315
plug-in, 477
ruler, 48
Scratch Disk, 478
Selection & Anchor Display, 470–471
slices, 475
smart guides, 53
Sync Settings, 468-469

text, 472–473
Transparency grid, 159
type, 472–473
Units Performance, 474
updates, 22
user interface, 479

presets
artboard, 36
creating new documents using, 31
exporting with, 436
list of, 31
printing with, 395, 404

Preview in browser (Save for Web), 463
Preview view, 40–41
Preview View command (View menu), 314
previewing

artboards, 38
color separations, 401
effects, 292
Save for Web, 463

Print command (File menu), 394, 396
Print Presets command (Edit menu), 395
printing

advanced print options, 404–405
bleed options, 399
color management settings, 406
color separations, previewing, 401
documents, 394
general print options, 396–397
graphics print options, 400
marks options, 398–399
number of copies, specifying, 397
output options, setting, 402–403
Overprint preview, 401
overprints, 404
presets, 404
with presets, 395
Print command, 394
print problems, checking for, 407
print tiling, 397
reverse order, 396
Separations preview, 401
spot colors, showing, 401
summary print options, 407

Product Improvement Program (Adobe), 25
Proof Colors command (View menu), 

132-133
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Proof Setup command (View menu), 41
proofing colors, 132-133
PSD format, 409
Pucker tool, 342
punctuation, 260

Q
Quit Illustrator command (Illustrator menu),

28
quotes, 35

R
radar graphs, 382-383
Radial Blur, 308-309
radial gradient type, 163
raster graphics

effects, 293, 302
interpolation and, 64
Resolution Independent Effects (RIE), 293
tracing, 278–282
understanding raster graphics, 64

Record button (Actions panel), 369
recording actions, 370
Rectangle Grid tool, 74
Rectangle tool, 69
Redo command (Edit menu), 59
Reflect tool, 101
reflecting objects, 97, 101
registration, 4–5
registration point, 365
releasing

compound paths, 193
objects from clipping masks, 195
objects to layers, 215

renaming
data sets, 381
selections, 92
workspaces, 61

rendering intent color management print
option, 406

replacing
colors, 124–125
fonts, 241
images, 18

Reselect command (Select menu), 90
Reset All Warning Dialogs, 467

Reshape tool, 180
reshaping objects, with Envelopes, 104-105
reshaping paths, 180–181
resizing

artboards, 38
slices, 458

Resolution Independent Effects (RIE), 293
resolution preset transparency setting, 35
Return to Adobe Illustrator command (File

menu), 16
reverse order printing, 396
Revert command (File menu), 26
revolving 3D effects, 299
RGB (Red, Green, Blue) color mode, 30, 111,

114
Rotate tool, 100
rotating

artboards, 38
objects, 97–98, 100
text, 247
touch type, 248-249

round bend style, 95
round joins, 139
Rounded Rectangle tool, 69
RTF format, 231
rulers

artboard display options, 39, 49
displaying, 48–49
document, 48–49
guides

alignment, 53
changing, 49
clearing, 51
color, 50
converting vector objects to, 51
creating, 51
locking, 50
preferences, 50
ruler, 49
showing and hiding, 50
smart guides, 52–53
snap to point, 50
style, 50
switching, 51

hiding, 49
origin, changing, 49
preferences, 48
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S
safe area, artboard display options, 39
Same command (Select menu), 91
saturation, color, 115
Save a Copy command (File menu), 27
Save As command (File menu), 27, 33
Save command (File menu), 26
SaveDocsAsPDF, script, 378–379
SaveDocsAsSVG, script, 378–379
Save for Web command (File menu),

438–441
as GIF format, 438-439, 446-447
as JPEG format, 438-439, 444-445
as PNG-8 format, 438-439, 448-449
as PNG-24 format, 438-439, 450

Save Selection command (Select menu), 82
Save Workspace command (Workspace

menu), 60
saving

actions
as files, 369
into sets, 369

brush library, 341
documents, 26–27

as EPS format, 430–431
as Microsoft Office, 434
as PDF format, 428–429
as SVG format, 432-433
as template, 435
for the Web, 438–439

selections, 82
slices for Web, 461
slices (from selection) for Web, 462
symbols, 347

Scale Strokes & Effects option, 467
Scale tool, 100
scaling

9-slice scaling, 362-363
objects, 97, 100
touch type, 248-249
type, 246

Scallop tool, 342
scatter brushes, 330–331
scatter graphs, 382-383
Scissor tool, 186
Scratch Disk preferences, 478
screen modes, 45

scribble effects, 295
scripts, actions, 378–379
searching

fonts, 240-241
for help information, 25

segments
curve, 173
moving, 172–173
paths and, 65
selecting with Direct Selection tool, 84

Select menu commands, 90–91
Edit Selection, 82
Same command, 91
Save Selection, 82

Selection & Anchor Display preferences,
470–471

Selection tool. See also selections
aligning and distributing objects using,

96
duplicating objects with, 94–95
moving objects with, 93
reflecting or shearing objects, 101
rotating and scale objects with, 100
selecting objects with, 83
transforming objects with, 97
understanding selections, 82

selections. See also Selection tool
anchor points, 84
controlling effects using, 307
deleting, 82
editing, 82
examples of, 82
inverting color of, 90
layers, 204
naming, 82
renaming, 82
reselecting, 90
saving, 82
selecting next object above/below 

current, 90
slices, 454–455
type, 232–233
understanding selections, 82

sentence case, 393
Separations Preview command (Window

menu), 41
Shape Mode command (Pathfinder panel),

190
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Shape Builder tool, 76-77
sharing on Behance (web site), 6, 19, 464
Shear tool, 101
shortcuts

starting Illustrator, 4–5
tool, 13

Show Asian Options, 472
Show Bounding Box command (View

menu), 97
Show Edges command (View menu), 65
Show Indic Options, 472
Show Panels command (Window menu), 20
Show Print Tiling command (View menu),

40
Show Text Threads command (View menu),

236
Show Transparency Grid command (View

menu), 159
sign in and out

Creative Cloud, 23, 506
Kuler web site, 122-123

simplify paths, 184
single quotes, 35
size

artboard, 37
font, 242
views, 42

Slice tool, 452
Slice Selection tool, 454
Slice Select tool (Save for Web), 440-441,

455
slices

alignment, 459
arranging, 458–459
auto, 452
combining, 460
deleting, 454
distributing, 459
dividing, 460
duplicating, 454, 460
hiding, 454–455
HTML text, adding, 456
images, optimizing to file size, 451
linking, 455
moving, 458
preferences, 475
resizing, 458
saving for Web, 461, 462

selecting, 454–455
showing, 454–455
stacking, 459
subslices, 453
unlinking, 455
URL links, adding, 457
user, 452
viewing slice options, 454–455
working with, 455

Smart Blur, 308-309
smart guides

object transformation, 99
preferences, 53
turning on/off, 52
working with, 52–53

Smart Punctuation, 260
smooth paths, 183
smooth points, converting to corner points,

174
Snap to Grid command, 54
Snap to Point command, 50, 470
soft proof colors, 132-133
spacing paragraphs, 253
spatter effects, 312
spell checking, 388–389
Spiral tool, 72–73
spirals, drawing, 72–73
splitting paths, 186–187
spot colors, showing, 401
stacked bar graphs, 382-383
stacked column graphs, 382-383
stacking slices, 459
stained glass effects, 312
stamp effects, 311
Star tool, 70
stars, drawing, 70
Start menu, opening documents using, 15
starting Illustrator

in Macintosh, 5
shortcuts, 4–5
in Windows, 4

status bar, 19
sync settings on Creative Cloud, 19

Stop button (Actions panel), 369
stops, adding to actions, 372
stroke

alignment, 138
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applying color to, 113, 128, 136-137
arrowheads, 140-141
attributes, changing, 138–141
caps or joins, changing, 139
dashed, 140
patterns as, 146–149
type, 266
weight of, changing, 138
widths, variable, 142-143

styles
font, 238-239
graphic

applying, 283
breaking links to, 287
creating, 284
deleting, 287
duplicating, 285
editing, 286

grids, 54
guides, 50
type, 258–259

Stylize command (Effect menu), 295
sublayers, 202–203
subscript text, 35
subslices, 453
subtracting panels, 10
summary print options, 407
superscript text, 35
SVG format, 27

saving as, 432-433
SaveDocsAsSVG, script, 378–379

Swatches Library
copying swatches between libraries, 120
customized swatch panels, saving, 121
displaying, 120
gradient library, 160, 162

Swatches panel
creating color groups in, 117
deleting colors from, 116
display of, changing, 116
editing or duplicating color in, 117
finding, 115-116
groups, creating, 118-119
sorting colors in, 116
swatches, displaying by type, 116
Swatches Library, 120–121

SWF format, Flash, 415, 424-425

sync settings
Creative Cloud, 469
preferences, 468-469
working with, 468

symbols
9-slice scaling, 362-363
creating, 346
deleting, 347
duplicating, 348
editing, 349
links, breaking, 350–351
pixel grid, align, 364
registration point, 365
saving, 347
sets, expanding instances of, 361
Symbol Libraries, 345
Symbol Screener tool, 359
Symbol Scruncher tool, 355
Symbol Shifter tool, 354
Symbol Sizer tool, 356
Symbol Spinner tool, 357
Symbol Sprayer tool, 352
Symbol Strainer tool, 358
Symbol Styler tool, 360
symbolism tool options, setting, 353
Symbols panel, 344

Symbol Libraries, 345
Symbol Screener tool, 359
Symbol Scruncher tool, 355
Symbol Shifter tool, 354
Symbol Sizer tool, 356
Symbol Spinner tool, 357
Symbol Sprayer tool, 352
Symbol Strainer tool, 358
Symbol Styler tool, 360
system requirements, 3

T
tab stops, 254
tabbed documents, 20
tabs, 254
Tabs panel, 254
Targa format, 415
templates

creating documents from, 32–33
document, 18, 32–33
saving documents as, 435
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template layer, creating, 218
text

anti-aliasing, 238, 251
baseline, character, 248-249
case, 393
clean up unneeded elements, 385
color, applying, 266
converting, 227
copying, 234–235
effects, 230
fonts, 238–242
glyphs, 261
hyphenation, 255
importing, 231
justification, 263
kerning, 244
leading, 243
moving, 229, 234–235
outlines, 265
overflow, 236–237
paragraphs, 252–253
preferences, 472–473
rotating, 247, 248-249
scaling, 246, 248-249
selecting, 232–233
spacing, 263
styles, 258–259
subscript, 35
superscript, 35
tabs, 254
threads, 236–237
touching up, 222, 248-249
tracking, 245
typing new, 223–224
wrapping, 264

Text Format, 415
Text Wrap command (Objects menu), 264
themes, color, 122–123
threads, text, 236–237
3D effects, 298–299
thumbnail views, 43
TIFF format, 409, 415, 417
Tolerance selection option, 470
tool tips, 467
tools

accessing in Tools panel, 12
accessing multiple, 12

Control panel, 6-7
moving between, 55
shortcuts to, 13

Tools panel
accessing tools in, 12
contents of, 6-7

touch screen
devices, using, 484
touch-enabled features, 62, 98-99

Touch Type tool 
using, 222, 248-249

tracing raster graphics, 278–281
tracking type, 245
transformations

applying multiple, 102–103
blends, 154
Distort & Transform command, 102
Transform panel, 106
repeating, 102
Transform Each command, 102

transforming objects, 97–99
Transform panel, 106
Transparency Flattener Presets command

(Edit menu), 405
Transparency grid, 159
transparency settings

blends, 156
colored paper simulation, 35
controlling transparency effects, 156
document creation, 34–35
flattening object transparency, 158
grid colors, 35
grid size, 34
opacity mask, 157
resolution preset, 35

trim marks, editable, 57
turning on/off smart guides, 52
TXT format, 231
type

Adobe World-Ready Composer (WRC),
256-257, 473

anti-aliasing, 238, 251
Area Type tool, 225-226
baseline, character, 248-249
color, applying, 266
converting, 227
copying, 234–235
deleting empty text paths, 234
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fonts, 238–242
justification, 263
kerning, 244
language options, 256-257, 472-473
leading, 243
moving, 234–235
OpenType fonts, 262
outlines, 265
overflow, 236–237
paragraphs, 252–253
preferences, 472–473
rotating, 247, 248-249
scaling, 246, 248-249
selecting, 232–233
spacing, 263
styles, 258–259
threads, 236–237
Touch Type tool, 248-249
tracking value, 245
Type on a Path tool, 228
Vertical Area Type tool, 225-226
Vertical Type on a Path tool, 228
Vertical Type tool, 223
wrapping, 264

Type on a Path tool, 222, 228
Type tool, 222-223
typographer's quotes, 35
Twirl tool, 342

U
Undo command (Edit menu), 59
undocking

documents, 21
panels, 10

unembedded graphics, 274–275
Ungroup command (Objects menu), 88
ungroup, color group, 119
Units Performance preferences, 474
Updater (Adobe). See Adobe Updater
updates

checking for, 22–23
preferences, 22

Updates command (Help menu), 23
updating, from previous versions, 2
uppercase text, 393
URL links, adding to slices, 457

user interface 
changing, 6-7
preferences, 6-7, 479

user slices, 452

V
variables, data

creating, 380–381
deleting, 380–381
renaming, 381

variable stroke widths, 142-143
vector objects

converting to guide, 51
effects, 303
understanding vector graphics, 64

Vertical Area Type tool, 222, 225-226
Vertical Type on a Path tool, 222, 228
Vertical Type tool, 222, 223
Video Data tab (File Info dialog box), 408
video safe areas, artboards, 37
View menu commands

Bounding Box, 324–325
Edit View, 40
Fit All In Window, 46
Fit Artboard In Window, 46
Hide Edges, 65
New View, 40
Overprint Preview, 41
Pixel Preview, 41
Preview View, 314
Proof Colors, 132-133
Proof Setup, 41
Rulers, 48
Show Bounding Box, 97
Show Edges, 65
Show Print Tiling, 40
Show Text Threads, 236
Show Transparency Grid, 159
Smart Guides, 52
Soft Proof, 132-133

view size, documents, 19
views

box color, 44
changing, with Zoom tool, 46–47
display view, changing, 40–41
document, 40–43
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views (continued)
fit in window, 46
Outline, 40–41
Preview, 40–41
ruler options, 48
size, 42
thumbnail, 43

Vimeo (Media Encoder), 502-503

W
Warp effect, 300
Warp tool, 342
Web

browser preview in (Save for Web), 463
file formats, 442–443
GIF files, optimizing, 438-439, 446–447
images, optimizing to file size, 451
JPEG files, optimizing, 438-439, 444–445
PNG-8 files, optimizing, 438-439,

448–449
PNG-24 files, optimizing, 438-439, 450
saving documents for, 438–439
saving slices for, 461

Web-safe color, 115
Window menu

Extensions, 477, 504
Flattener Preview, 41, 405
Hide Panels, 20
panel display, 8–10
Separations preview, 41
Show Panels, 20

Windows
Illustrator system requirements, 3
installing Illustrator in, 2
starting Illustrator in, 4

windows
active, 20
document, 20–21

Windows Metafile format, 415
Workspace menu commands, 60
workspaces

creating, 60
deleting, 61
displaying, 60
layouts, 60
naming, 60
renaming, 61

wrapping text, 264
Wrinkle tool, 342

X
X and Y positioning, 37
XML, SVG, 432-433
XMP metadata, 408-409
XMP Software Development Kit, 409
Xoom device, 31

Y
YouTube (Media Encoder), 502-503

Z
zoom

in/out, 47
using Navigator thumbnail, 43
view size, 42

Zoom tool
changing view with, 46–47
Save For Web tool, 404
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